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Introduction

1

Introduction

1.1

What is Spotfire Deployment and
Administration?
Spotfire deployment includes deploying packages that will be automatically
downloaded by Spotfire clients, creating users and groups, setting up licenses, and
setting up the library.
Spotfire administration includes tasks like adding new users and groups to the system,
manage lincenses, and upgrading to new versions.
All of these tasks are performed using different tools. This manual introduces these
tools and explains what tasks to perform in each of them. Further assistance can be
found in the online help of each tool.

1.2

The Spotfire Administrator
The Spotfire Admin is a Spotfire user with administrative privlileges. He or she is
responsible for adding users and groups, configuring up licenses and preferences and
deploying new packages. The Spotfire Admin can be identical to the Spotfire Server
administrator, but does not have to be. When the Spotfire Server is installed, the
Server administrator assigns Spotfire Admin privileges to a Spotfire user (and creates
it if necessary). This user becomes the first Spotfire Admin. He or she can then assign
Admin privileges to other Spotfire users at need.
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2

TIBCO Spotfire Administrative Tools

2.1

Overview
There are three different tools used to perform Spotfire administrative tasks. It is
important that Spotfire Admins are familiar with all of them.

2.2

TIBCO Spotfire Administration Console
Each TIBCO Spotfire Server has a web-based administration UI called the TIBCO
Spotfire Administration Console. This tool is used to set up users (unless users and
groups are handled by an external mechanism such as an LDAP server) and groups,
and to create and upload deployments. It can be reached by a standard web browser
using the URL http://spotfireserver/spotfire/administration/, where
spotfireserver is the hostname of one of your Spotfire Servers. It does not matter
which server in the cluster you use; changes made to one server will be stored in the
Spotfire Database and available to all servers. If there is a load balancer in front of the
Spotfire Servers, you should use its hostname in place of spotfireserver.

2.3

TIBCO Spotfire Administration Manager
In the Spotfire client, there is an administration tool called the Administration
Manager. This tool is used to set up licenses and preferences. It is also possible to
create new users and groups in this tool. It is found on the Tools menu in the Spotfire
client.

2.4

TIBCO Spotfire Library Administration
In the Spotfire client, there is also an administation tool called the Library
Administration. This tool is used to administer the Spotfire Library. The Library is a
feature that allows Spotfire users to publish and share analyses and data with each
other.
The content of the Library can be exported and imported using the Library
Administration tool. This can be used as a backup function.

2.5

TIBCO Spotfire Server Logs and
Diagnostics
For each TIBCO Spotfire Server you can view logs and diagnostics in the Server Logs
and Diagnostics tool, available at the URL http://spotfireserver:80/spotfire.
Replace spotfireserver with the name of the Spotfire Server.

TIBCO Spotfire® 5.5

5 (27)

TIBCO Spotfire Administrative Tools

Log in with a user that has either Spotfire Administrator or Spotfire Diagnostics
Administrator permissions. For more information about Spotfire permissions and
administrator roles, see the section “Setting Up Groups” on page 12.
Server Logs will provide detailed information about what is happening on the server,
such as access logs, SOAP communication, Information Links that are used, etc.
Diagnostics will provide information about the server itself, such as information about
the Database Server, Operating System, TIBCO Spotfire Server, Cluster
Configuration, Application Server, System, and Java version.
Note: Any changes made to the log configuration using this tool will be reverted upon
restart of the Spotfire Server. Changing the default log level must be done by manually
editing a configuration file on the Spotfire Server. See the TIBCO Spotfire Server Installation and Configuration Manual for more information about this.
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Setting Up TIBCO Spotfire

3.1

Overview
UPGRADING FROM 3.0, 3.1, 3.2, 3.3, 4.0, 4.5 or 5.0?

TIBCO Spotfire 5.5 requires Microsoft .NET Framework 4. The
TIBCO Spotfire 5.5 installer will install this, if not present on the
machine.
If you are upgrading from TIBCO Spotfire 3.0, 3.1, 3.2, 3.3, 4.0, 4.5 or
5.0 to 5.5, all you need to do is deploy new Spotfire packages to the
server. However, before you do this, you must also install the .NET
Framework 4 on all the machines running TIBCO Spotfire. See the
section “Deploying Spotfire Packages” on page 8 for detailed
instructions on how to deploy packages.
You will need the "full" version of .NET Framework 4. The "Client
Profile" version will not work.
Note that TIBCO Spotfire 5.5 requires TIBCO Spotfire Server 5.5.
Starting with 3.1, there is a new Spotfire Administration tool called
Administration Console. You should read the section “TIBCO Spotfire
Administrative Tools” on page 5 to familiarize yourself with this new
tool.
You should also read the section “Spotfire Licenses” on page 18 for an
overview of the licenses and features in TIBCO Spotfire 5.5.
TIBCO Spotfire 5.5 requires TIBCO Spotfire Server 5.5.
When the Spotfire Server is installed and configured, there are a number of tasks that
need to be performed before users can log in and use Spotfire:
1

Deploying Spotfire packages.

2

Installing TIBCO Spotfire on a computer.

3

Setting up Users, Groups, Licenses and Preferences.

4

Setting up the Spotfire Library.

5

Installing TIBCO Spotfire for all users.
Each of these steps is described in detail below.

TIBCO Spotfire® 5.5
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3.2

Deploying Spotfire Packages
When a user logs into TIBCO Spotfire, the client will check for new software
packages on the server and automatically update the client with them. It is important
that these packages are deployed to the server for the clients to work properly. After
installing TIBCO Spotfire Server, the Spotfire Admin must create an initial
deployment. It is also important that any client hotfixes released by TIBCO, or any
other add-on software, are deployed to the server.
When installing the Spotfire Server for the first time, one deployment area exists, the
default deployment area, and the name of that area is set to "Production".
Deployment areas can then be set for groups in the Spotfire database, and when one is
set for a group, all group members can access the deployments in that area.
Note: It is not possible to specify a deployment area for the Deployment Administrator
and Administrator groups. These groups can access all deployment areas.
It is possible to add, delete and rename deployment areas. The default deployment area
can be changed, but not removed. The default deployment area is ignored for a user as
soon as a deployment area is specified for a group the user belongs to. If no
deployment area is set for a group, the group members get the default deployment
area.
Deployment areas are assigned to groups in the Groups tab and when a user logs in to
the Spotfire Client the following will happen:


If a deployment area is specified for one, and only one, of the groups the user is
a member of, the user will get the packages for the area specified and will not be
prompted to choose deployment area.



If more than one deployment area is available because the user belongs to
several groups with different deployment areas assigned, the user will be
prompted to choose between the deployment areas set for the different groups.



If no deployment area is specified for any of the groups the user belongs to, the
user gets the default deployment area.

Example: Multiple Deployment Areas
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Group 1
No deployment area is assigned and the users will get the default deployment
area when logging in to TIBCO Spotfire. Users will not be prompted to select
deployment area.
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Group 2
Users will get the Chemistry deployment area when logging in to TIBCO
Spotfire. Users will not be prompted to select deployment area.



Group 3
Users will get the Statistics deployment area when logging in to TIBCO
Spotfire. Users will not be prompted to select deployment area.



Group 4
Users will be prompted to select between the Statistics and the Chemistry
deployment areas when logging in to TIBCO Spotfire.

If for example a group of users cannot run a certain version of the Spotfire client or if
you want a specific group of "early adopters" try out a new version of the Spotfire
client, this can be done smoothly by assigning a specific Deployment Area to those
groups since other users will not be affected by this. By assigning different
deployment areas to different groups it is also possible to have fine grained control
over what deployments are available to the user.
A test area can be created and used as a staging server, and when confident that
everything works as it should, you can move that deployment to areas "in production".
It is recommended to carefully think through how to set up the deployment areas and
make sure that users as rarely as possible are prompted to choose deployment area.
This section describes how to create a deployment. Further help is also available in the
Administration Console online help.



To Deploy Spotfire Packages

1

Open the Administration Console located at http://spotserver/spotfire/
administration (where spotserver is the name of one of your spotfire servers) in a web
browser.

2

Log in as a Spotfire Admin.

3

Select the tab Deployment.

4

Select an existing Deployment Area from the Deployment Area list or create a new
Deployment Area to which you want to deploy packages
Note: It is recommended to use an area that is not in production, especially if you are
upgrading from a previous version of TIBCO Spotfire. You can for example create a
“test deployment area” and later copy the deployment from that “test area” after you
have installed a TIBCO Spotfire client and verified that the deployment is downloaded
and installed upon login.

5

If there are any old packages in the environment, click the Clear button to remove all
packages.
Comment: If you have any third-party packages that you know will work with this
version of TIBCO Spotfire, you can keep these. In this scenario, rather
than clicking the Clear button, you should remove unwanted packages one
by one.

TIBCO Spotfire® 5.5
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6

Click the Add button.
Response: An Add to Deployment dialog appears.

7

Click the Browse button.
Response: A File Upload dialog appears.

8

Browse to a package file (.spk) or a distribution file (.sdn) that you want to include in
the deployment.
A distribution file (.sdn file) is made up of package files (.spk files) that may have
dependencies on one another. The Spotfire.Dxp.sdn distribution is the most
frequently encountered example of a distribution file and is located in the deployment
kit folder TIB_spotdeploy_5.5.0_win\Products\TIBCO Spotfire Distribution.

9

Click OK in the Add to Deployment dialog to upload and add the file to the
distribution.
Response: The list of packages is updated with the contents of the file.

10

Remove any unwanted files from the list by selecting them and clicking the Remove
button.

11

Click the Validate button in the lower left corner to make sure the deployment is not
damaged or corrupted in any way.

12

Click the Save button in the lower left corner to save and publish the deployment.
Response: The Save Deployment dialog appears.

13

Enter a version number and a description for the deployment and click the OK button.
See also the online help of the Administration Console.

3.3

Installing TIBCO Spotfire on a Computer
You must now install a TIBCO Spotfire client on your computer, to verify that the
deployment you have created works, and to get access to the Administration Manager
and the Library Administration tools.
TIBCO Spotfire is installed using an installer found in the \Products\TIBCO
Installer folder of the Spotfire distribution.


1

Spotfire

To Install TIBCO Spotfire on a Computer
Copy the Client Installer folder to your local disk, and run the setup.exe file.
Response: The installer starts, and the Welcome screen is shown.

2
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Click Next to continue.
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3

Read the TIBCO Spotfire license agreement. Select the I accept radio button to accept
and click Next to continue.

4

Specify the URL of your TIBCO Spotfire Server. Click Next to continue.
Comment: If there are several TIBCO Spotfire Servers installed, and a load balancer
in place in front of them, specify its URL.

5

Click Install to start the installation.

6

When TIBCO Spotfire has been installed, click Finish to close the installer.
Response: TIBCO Spotfire is now installed.
You should now start TIBCO Spotfire on your computer and log into the deployment
area to which packages were deployed in “Deploying Spotfire Packages” on page 8. In
the following instructions it is assumed that packages were deployed to an area named
“test”.
Log in to the “test” deployment area on your server to verify that login works and that
you receive Spotfire package updates.

1

Start TIBCO Spotfire.
Response: TIBCO Spotfire starts and displays a login dialog.

2

Click Manage Servers...
Response: The Manage Servers dialog appears.

3

Click the button Add...
Response: The Add Server dialog appears.

4

Enter the URL to your Spotfire Server.

5

Click OK.

6

Click OK.

7

Enter your Username and Password to log into the Spotfire Server.

8

Click Login.
Response: You are logged into the Spotfire Server. You should also receive package
updates from the deployment in the Test Environment.
Note: You may be prompted to select a Deployment Area. See the example in “Example: Multiple Deployment Areas” on page 8.
Comment: Package "updates" may in fact be "downgrades", if the files deployed to
the server are older than the installed TIBCO Spotfire. This can be a useful
in a situation where an administrator for some reason wants to downgrade
all clients. It is however not possible to downgrade to a lower major

TIBCO Spotfire® 5.5
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version, for example from 5.5 to 5.0, or even to log into a server with a
deployment with a lower major version number than the client. For this
reason, you must deploy 5.5 packages to the server before you can log into
it with a 5.5 client.
If all this seems to work and you wish to copy the deployment to the Default
Deployment Area, go back to the Administration Console and do the following:
1

In the Administration Console, select the Deployment tab.

2

Select the “test” area.

3

Click the Copy button.
Response: The Copy Deployment dialog appears.

4

Select to copy the deployment to the Default Deployment Area.

5

Click OK.
Response: The content of the “test” area is copied to the production area.
Tip: When you receive new updates from TIBCO or from a third-party, deploy these
updates to the Test Environment and test them before you copy them to the Production
Environment. This way you can test a new deployment without disturbing your
Spotfire users.

3.4

Setting Up Users
During Spotfire Server installation and configuration, Spotfire Authentication is set
up. Spotfire can authenticate users using either internal authentication (Spotfire
Database) or external authentication (LDAP directory or Windows Domain). If
internal authentication is used, you can add and delete users and change their
passwords using either the Administration Console or the Administration Manager. If
external authentication is used, users are imported into the Spotfire Database when
they first log in. You cannot remove imported users from within the Spotfire system.
Users can be managed in the Administration Console or in the Administration
Manager on the Users tabs in both tools. Refer to their online helps for detailed
instructions.

3.5

Setting Up Groups
Spotfire groups are used to organize users. Groups can be synchronized from an
external source, such as an LDAP directory or a Windows Domain, or created and
managed locally in the Spotfire Database. This is set up during Spotfire Server
installation. Synchronized groups cannot be deleted from within the Spotfire system.
You can, however, create local Spotfire groups and place imported users and
synchronized groups in them. This is important when you set licenses on groups in the
next section.
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Groups can be managed in the Administration Console or in the Administration
Manager on the Groups and Groups and Licenses tabs respectively. Refer to their
online helps for detailed instructions.
Roles and Special Groups
In the Spotfire System, there are a number of special groups that are present at
installation time and that are not possible to remove. These groups define different
roles. Roles can be viewed as different sets of tasks the members of the groups are
supposed to and allowed to perform. To assign a role to a user, simply add him or her
to one of the special groups listed below. Note that some roles require not only
membership in the groups, but also that a certain license is set on the group in
question. For more information about licenses, see the next section.
Role

Description

Administrator

Membership in this group grants all permissions
described below in addition to administration of
preferences, licenses, and user directory.
Important: This group must have the TIBCO Spotfire
License enabled to be able to administer the Spotfire
system.
Note: In version 3.2 and onward, membership in this
group also grants Library Administrator permissions.

Library Administrator

Membership in this group grants full permission to the
Library, and the permission to import and export
Library content.
Important: This group must have the TIBCO Spotfire
Library Administrator License enabled to be able to
administer the Library.

Deployment Administrator

Membership of this group grants permission to deploy
packages to the server(s). Note that these users can
deploy to any area on the server, as well as delete any
existing deployment.

Diagnostics Administrator

Membership of this group grants permission to view
server logs and diagnostics, as well as to set server
logging configurations. It also grants permission to
view information in the Web Player diagnostics page.
Note: The number of logging configurations available
can be decided by the server administrator. For more
information about this see the TIBCO Spotfire
Server Installation and Configuration Manual.

TIBCO Spotfire® 5.5
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Impersonator

Membership of this group grants permission to
Impersonate. It is recommended that users that
belongs to this group does not have additional
privileges. See the TIBCO Spotfire Server
Installation and Configuration Manual for more
information about Impersonation.

Web Player Administrator

Membership in this group grants permission to view
Web Player diagnostics and to set up Scheduled
Updates tasks.

Scheduled Updates Users

Membership in this group grants permission to
perform Scheduled Updates.

Script Author

Membership in this group grants permission to author
scripts. The user must also have the Author Scripts
license in order to author scripts.
Note: Scripts executed by the Web Player can
essentially do anything deployed packages can do.
Therefore you should only grant this permission to
trusted users.

In addition to the special groups defining roles, there is also one other special group:
Everyone

3.6

This group contains all users in the Spotfire system.
Thus it is not possible to remove users from it.

Setting Up Licenses
Spotfire licenses control what features are available to users. Licenses are always
configured per group, never on individual users. When a user logs in, only the features
enabled to the groups the user belongs to appear in Spotfire. You should apply licenses
to groups when you create them. Because groups can belong to groups, licenses are
inherited from the parent group.
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Example:

In this example, the license TIBCO Spotfire Professional is set on the group ACME
Spotfire Users. This license is then inherited by all groups belonging to the ACME
Spotfire Users group, situated below it in this illustration. The license TIBCO Spotfire
Metrics is set on the group ACME Analysts and inherited by its child groups, ACME
Foold Analysts and ACME Drink Analysts.
When initially setting up Spotfire Licenses, it is a good idea to set licenses as “high
up” in the hierarchy as possible, to take full advantage of group inheritance.
Licenses are set on the Groups and Licenses tab in the Administration Manager in the
Spotfire client. For detailed instructions on how to use this tool, see its online help.
For a full list of Spotfire licenses, see the section “Spotfire Licenses” on page 18.

3.7

Setting Up Preferences
Spotfire Preferences control the Spotfire experience. It includes which font to use for
labels, the default marker shape of scatter plots, and many other things. They are set on
groups and inherited just like licenses.
Preferences are set on the Preferences tab in the Administration Manager in the
Spotfire client. For detailed instructions on how to use this tool, see its online help.
Note: Users may set preferences in the Spotfire client. Preferences set in the
Administration Manager come into effect if a user has not set preferences.

TIBCO Spotfire® 5.5
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3.8

Setting up Connection to TIBCO Spotfire
Statistics Services
TIBCO Spotfire 5.5 provides support for connecting to TIBCO Spotfire Statistics
Services. Most settings regarding this are set in the TIBCO Spotfire client. See its
online help for more information about this. URLs to Statistics Services servers
running S-PLUS or R engines are however also configurable as Spotfire Preferences
in the Administration Manager. On the Preferences tab, select the group for which the
URLs should be set and then select the tab Preferences. Find the TIBCO Spotfire
Statistics Services in the list and click Edit. Enter the URL to the TIBCO Spotfire
Statistics Services server running a S-PLUS engine and/or the TIBCO Spotfire
Statistics Services server running a R engine. For detailed instructions on how to use
the Administration Manager, see its online help.
Concerning R:
R is available under separate open source software license terms and is not part of
TIBCO Spotfire. As such, R is not within the scope of your license for TIBCO
Spotfire. R is not supported, maintained, or warranted in any way by TIBCO Software
Inc. Download and use of R is solely at your own discretion and subject to the free
open source license terms applicable to R.

3.9

Setting Up the Spotfire Library
The Library is where users store and share analyses. A Spotfire Admin, or a Library
Admin assigned by the Spotfire Admin, should set up the library before the users start
storing analyses here. This includes building a folder structure with appropriate
permissions for the different groups to read and write to the different folders. By
setting “owner” permissions for a certain group to a number of folders, you can
delegate responsibility for that part of the Library to a certain group within your
organization.
Library Admins
Library Admins are Spotfire users belonging to the special Library Administrator
group. Library Admins have sufficient permissons to create folders on the root level of
the Library, and also have full access to the entire Library. As a Spotfire Admin, you
could make yourself a Library Admin, or delegate this responsibility to others.
Design Guidelines
The key to a successful Library design is structure. How you structure your Library is
up to you, but here are a few suggestions:
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By department. This would, for instance, allow all engineers to access the same
analyses.



By project. This would allow all users working in the same project to access the
same analyses. Using inheritance, you could allow different sub-projects to
access their parent project files, and still restrict sister-projects from reaching
each other’s material.
TIBCO Spotfire® 5.5
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By geography. This would allow, for instance, different offices to have access to
different parts of the Library.

It is usually a good idea to have the Library structure reflect the structure of your
organization.

TIBCO Spotfire® 5.5
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4.1

List of all Spotfire 5.5 Licenses and
Features
There are ten Spotfire licences in total:
TIBCO Spotfire Clinical

Enables TIBCO Spotfire Clinical.

TIBCO Spotfire Web Player

Enables TIBCO Spotfire Web Player.

TIBCO Spotfire Enterprise
Player

Enables TIBCO Spotfire Enterprise Player, a TIBCO
Spotfire client running with a subset of all features
included in TIBCO Spotfire Professional. For
technical reasons, this license is also required to run
TIBCO Spotfire Web Player.

TIBCO Spotfire Professional

Enables TIBCO Spotfire Professional, which includes
all the standard features in the TIBCO Spotfire client,
except the features included in the license TIBCO
Spotfire Enterprise Player. It is important that any
groups with this license enabled also have the TIBCO
Spotfire Enterprise Player enabled.

TIBCO Spotfire Metrics

Enables additional calculation tools.

TIBCO Spotfire Extensions

Enables usage of custom extensions which may be
added by developers in your organization. When new
custom license features are deployed to the TIBCO
Spotfire Server, they will appear under this license.

TIBCO Spotfire Information
Modeler

Enables tools and permissions to create and edit
database connections for information links.

TIBCO Spotfire
Administrator

Enables access to the Administration Manager and the
Library Administration tool (the administration tools
available within the Spotfire client).
Important: To administer the Spotfire system, this
license is not enough. The user must also be a Spotfire
Admin, that is a member of the special Administrator
group. If the users needs full access to the Library, he
or she must also be a member of the special Library
Administrator group.
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TIBCO Spotfire Qualification

Enables TIBCO Spotfire Qualification.

TIBCO Spotfire Connectors

Enables users to connect and analyze data in-database.

TIBCO Spotfire® 5.5
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Each of these licenses consists of a number of license features. These features are
listed below, grouped with each license.
TIBCO Spotfire Clinical
Open Oracle Clinical Data

Enables a user to open Oracle Clinical data.
Note: Sold as a separate license.

TIBCO Spotfre Web Player
TIBCO Spotfire Web Player

License to use the Web Player.

External updates of analysis
files in TIBCO Spotfire Web
Player

Enables a user to perform updates of analys files
through the Web Player Server Updater Service API.

TIBCO Spotfire Enterprise Player
Open File

Enables the File > Open... menu item and makes files
available in the list of most recently used files.
Without this, a user cannot open files from within
Spotfire.
(This is mainly used in certain Citrix environments.)

Open from Library

Allows a user to open a file from the Spotfire Library.

Open Linked Data

Allows a user to open an analysis file with linked data.

Save Spotfire Analysis File

Allows a user to save a Spotfire Analysis file. (This
specific license feature also enables/disables the
"Open in Spotfire" button in the Spotfire Web Player)

Save to Library

Allows a user to save a file to the Spotfire Library.

Export to PowerPoint

Allows a user to export to Microsoft PowerPoint.

Export to PDF

Allows a user to export to PDF

Export Image

Allows a user to export a visualization as an image.

Export Data

Allows a user to export or copy the data used in a
visualization.

Print

Allows a user to print visualizations to paper.

Details on Demand

Allows a user to display the Details-on-Demand panel.

Undo/Redo

Allows a user to Undo/Redo actions

Bookmarks

Allows a user to work with bookmarks.

Capture Private Bookmarks

Allows a user to work with private bookmarks.

TIBCO Spotfire® 5.5
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Capture Private and Public
Bookmarks

Allows a user to work with private and public
bookmarks.

Change Password

Allows a user to change password.

Share to tibbr®

Allows a user to share visualizations via tibbr®.

Collaboration Panel

Allows a user to use the Collaboration Panel.

TIBCO Spotfire Professional
Open File Data

A user can always open *.dxp files from the Open
menu provided the "Open File" license feature is
enabled. This license feature enables a user to also
open *.sfs, *.sdf,*.txt, *.csv, *.xml, and *.xls files, and
to paste data from the clipboard.

Open Database Data

Allows a user to open data from databases.

Open Information Links

Allows a user to open data from Information Links.

Open Custom Made File

Allows a user to open custom made files.

Replace Data

Enables the File > Replace Data Table... menu item.
The available submenu alternatives
are determined by the four "Open..." license functions
above.

Merge Data

Allows a user to insert and merge additional data to an
open analysis. This is done
from the Replace Data Table and Insert Column/Rows
options.
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Insert New Column

Allows a user to insert a new column of data to an
open analysis.

Manage Data Tables

Allows a user to add and work with more than one
data table in an analysis

Load Data on Demand

Allows a user to load data from information links on
demand.

Create Information Link

Allows a user to create a new information link using
predefined elements.

Create Page

Allows a user to create a new Page.

Create Table

Allows a user to create a new Table visualization.

Create Graphical Table

Allows a user to create a new Graphical Table
visualization.
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Create Cross Table

Allows a user to create a new Cross Table
visualization.

Create Bar Chart

Allows a user to create a new Bar Chart visualization.

Create Line Chart

Allows a user to create a new Line Chart visualization.

Create Combination Chart

Allows a user to create a new Combination Chart
visualization.

Create Pie Chart

Allows a user to create a new Pie Chart visualization.

Create Scatter Plot

Allows a user to create a new Scatter Plot
visualization.

Create 3D Scatter Plot

Allows a user to create a new 3D Scatter Plot
visualization.

Create Map Chart

Allows a user to create a new Map Chart visualization.

Create Treemap

Allows a user to create a new Treemap visualization.

Create Heat Map

Allows a user to create a new Heat Map visualization.

Create Parallel Plot

Allows a user to create a new Parallel Coordinate Plot
visualization.

Create Summary Table

Allows a user to create a new Summary Table
visualization.

Create Text Area

Allows a user to create a new Text Area.

Action Links

Allows a user to create Action Links.

Change Column Selector

Allows a user to interact with column selectors and
data table selectors in a visualization. It also allows a
user to adjust binning sliders and hierarchy sliders, and
to alter the order of multiple columns on an axis.

Simple Visualization
Properties

Allows a user to change plot properties using the axis
selectors, or to drag and drop columns from other
visualizations or the Filter Panel. (This license feature
also enables everything in the Change Column
Selector license feature.)

Advanced Visualization
Properties

Allows a user to change all plot properties via the
Visualization Properties dialog.
(This license feature also enables everything in the
Change Column Selector and Simple Visualization
Properties license feature.)

Error Bars

TIBCO Spotfire® 5.5

Allows a user to display error bars in a visualization.
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Simple Filter Panel Properties

Allows a user to change filter type.

Advanced Filter Panel
Properties

Allows a user to hide, move and group filters, and
access the Filtering Scheme Properties dialog and
Organize Filters dialog.

Simple Data Properties

Grants access to the Edit > Column Properties dialog.

Advanced Data Properties

Enables additional functionality in the Column
Properties dialog, such as, Details, Edit, Freeze
Columns, Insert, Column Properties, Sort Order and
Hierarchies.

Advanced Document
Properties

Grants access to the Edit > Document Properties
dialog, the Tools > Options dialog and also allows the
user to assign a filtering scheme to a page.

Tags

Allows a user to work with Tags.

Use Custom Made Tools

Allows a user to open custom made tools.

Change Exportability for Web
Player Table Data

Allows a user to specify whether the data in a Table,
Summary Table or Cross Table, should be able to be
exported if the analysis is opened in the Spotfire Web
Player. If disabled, a default value or preference will
determine if the data in the table can be exported from
the Web Player. Set these preferences from the
Preferences tab.

Lists

Allows a user to work with Lists.

Load Data from ActiveSpaces

Allows a user to load data from TIBCO ActiveSpaces.

TIBCO Spotfire Metrics
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Create Box Plot

Allows a user to create a new Box Plot visualization.

Advanced Aggregation
Methods

Provides more aggregation methods in addition to the
standard Sum, Average, Count and Unique Count.

Custom Expressions

Grants access to the Custom Expressions option on the
column selectors.

Set Column From Marked

Grants access to the Column from Marked option on
the column selectors.

Line Similarity

Grants access to the Line Similarity tool.

K-Means Clustering

Grants access to the K-Means Clustering tool.

Hierarchical Clustering

Allows a user to use hierarchical clustering.
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Data Relationships

Grants access to the Data Relationships tool.

Curve Draw

Allows a user to add a curve to a visualization by
entering an expression for the curve.

Curve From Data Table

Allows a user to add a curve to a visualization by
importing it from a data table.

Straight Line

Allows a user to add a Straight Line Fit to
visualizations.

Polynomial Curve

Allows a user to add a Polynomial Curve to
visualizations.

Logistic Regression Curve

Allows a user to add a Logistic Regression Curve to
visualizations.

Power Curve

Allows a user to add a Power Curve to visualizations.

Gaussian Curve

Allows a user to add a Gaussian Curve to
visualizations.

Logarithmic Curve

Allows a user to add a Logarithmic Curve to
visualizations.

Exponential Curve

Allows a user to add a Exponential Curve to
visualizations.

Register Data Functions

Allows a user to register data functions.

Execute Data Functions

Allows a user to execute data functions.
Note: If you do not grant this license, you should NOT
grant licenses for Enable Local TERR Engine,
Predictive Modeling, or Insert Predicted Columns.

TIBCO Spotfire® 5.5
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Enable Local TERR Engine

Allows a user to specify that an analysis (during
authoring or deployment) uses a local instance of
the TIBCO Enterprise Runtime for R engine
(rather than running on the available TIBCO
Enterprise Runtime for R engine in Spotfire
Statistics Services).
TIBCO Enterprise Runtime for R for Spotfire data
functions (enabled through the Register Data
Functions and Execute Data Functions licences)
require access to a TIBCO Spotfire Statistics Services
configured with a TIBCO Enterprise Runtime for R
engine, even if users should be allowed to use the local
engine.
If this license is not granted, then all TIBCO
Enterprise Runtime for R for Spotfire data functions
are executed using the TIBCO Enterprise Runtime for
R engine available on TIBCO Spotfire Statistics
Services, regardless of the Use locally installed
Enterprise Runtime for R setting in the Tools >
Options - Data Functions dialog.
If this license is granted, the engine choice is
determined by the state of the Use locally installed
Enterprise Runtime for R check box in the Tools >
Options - Data Functions dialog.
If this license is not granted, you should not grant
licenses for Predictive Modeling and Insert
Predicted Columns; otherwise, users might encounter
irregularities.
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Predictive Modeling

Allows a user to create, edit and manage Regression
and Classification Models.
If this license is not granted, the Regression Modeling
and Classification Modeling menu items will not
appear.
Even if a user lacks this license, any existing analyses
containing results from the predictive modeling tools
will continue to function and update based on the data
as necessary. (That is, the underlying data functions
continue to work.)
If this license is granted, you should also grant licenses
for Execute Data Functions and Enable Local
TERR Engine.

Insert Predicted Column

Allows a user to use a predictive model in an analysis
to add predicted columns to a data table.
If this license is not granted, the Predicted Columns
menu item under Insert will not appear.
Even if a user lacks this license, any existing analyses
containing predicted columns will continue to function
and update based on the data as necessary. (That is, the
underlying data functions continue to work.)
If this license is granted, you should also grant licenses
for Execute Data Functions and Enable Local
TERR Engine.

TIBCO Spotfire Extensions
Access to Extensions

This license enables users to view and use custom
extensions which may be added by developers at your
company. When new custom license features are
deployed on the Spotfire Server, they will appear
under this license. You can then enable or disable each
individual license feature if you wish.

Accord

Allows a user to use the Accord tool.

Author Scripts

Allows a user to author scripts. The user must also be a
member of the Script Author group in order to author
scripts.
Note: Scripts executed by the Web Player can
essentially do anything deployed packages can do.
Therefore you should only grant this permission to
trusted users.

Automation Services Job
Builder Tool

TIBCO Spotfire® 5.5

Gives a user access to the Automation Services Job
Builder tool.
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ChemDraw

Allows a user to use the ChemDraw tool.

ChemIQ

Allows a user to use the ChemIQ tool.

ChemistryViewer

Allows a user to use the ChemistryViewer tool.

ExportToSDF

Allows a user to use the ExportToSDF tool.

Marvin

Allows a user to use the Marvin tool.

Qualification Compare Tool

Allows a user to use Qualification Compare.

Qualification Export Tool

Allows a user to use Qualification Export.

SDFParser

Allows a user to use the SDFParser tool.

StructureSearch

Allows a user to use the StructureSearch tool.

Symyx® Draw (MDL)

Allows a user to use the Symyx® Draw (MDL) tool.

TIBCO Spotfire Information Modeler
Administration

Allows a user to modify data sources, joins and other
elements when working with Information Links.
Note: The user must also have the Create Information
Link feature enabled, to access the tool itself.

Prompt for Parameter

Note: The user must also have the Create Information
Link feature enabled, to access the tool itself.

TIBCO Spotfire Administrator
Administration

Note: The user must also have the Create Information
Link feature enabled, to access the tool itself.

Library Administration

Grants access to the Library Administration tool and
its functionality.

TIBCO Spotfire Qualification
TIBCO Spotfire Qualification

Allows users to verify that analyses in TIBCO Spotfire
yields the same results on different installations of
TIBCO Spotfire.
Note: Sold as a separate license.
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TIBCO Spotfire Connectors
ADS Composite Information
Server

Allows a user to add connections to ADS Composite
Information Server and analyze data in-database.
Note: This is an additional connector that can be
deployed on the server. It is not embedded in the
standard Spotfire distribution.

IBM Netezza

Allows a user to add connections to IBM® Netezza®
and analyze data in-database.
Note: This is an additional connector that can be
deployed on the server. It is not embedded in the
standard Spotfire distribution.

Microsoft SQL Server

Allows a user to add connections to Microsoft® SQL
Server® and analyze data in-database.

Microsoft SQL Server
Analysis Services

Allows a user to add connections to Microsoft® SQL
Server® Analysis Services and analyze data indatabase.

Oracle

Allows a user to add connections to Oracle® and
analyze data in-database.

Oracle MySQL

Allows a user to add connections to Oracle® MySQL
and analyze data in-database.
Note: This is an additional connector that can be
deployed on the server. It is not embedded in the
standard Spotfire distribution.

PostgreSQL

Allows a user to add connections to PostgreSQL® and
analyze data in-database.
Note: This is an additional connector that can be
deployed on the server. It is not embedded in the
standard Spotfire distribution.

SAP BW

Allows a user to add connections to SAP® Business
Information Warehouse (SAP BW) and analyze data
in-database.
Note: This is an additional connector that can be
deployed on the server. It is not embedded in the
standard Spotfire distribution.

Teradata

TIBCO Spotfire® 5.5

Allows a user to add connections to Teradata® and
analyze data in-database.
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